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OPERATING SYSTEM 
Organisation of information using an Operating System 
In this lesson we are going to demonstrate the concept of information management using Microsoft Windows as an operating system.
Windows organizes information into drives, folders/directories and files.
A file is a collection of related data or information given a unique name for identification. For
example Your class register if keyed into a computer it may be given a name like (Form1Register). 

A folder is named storage location for storing related files for ease of access. Some operating system refers to it as a Directory . For example all the registers for all the classes can be stored in a folder called (Students Registers). You can create more folders within a a folder, these are called subfolders. 

A drive refers to a physical or logical storage location on an auxiliary storage media. For example the default hard disk is identified as a drive C: The drive letters range from A-Z and denoted by a letter followed by a colon. 
In summary, Windows organizes information into files, folders (or even subfolders) and drives. The chart below shows a tree structure of information storage in drive C:

Creating folders and subfolders
To create folders you need to identify the drive in which the folder will reside.
For example let us create a folder called Registers in the local drive C. To do this:
1. Right-click My computer icon. 
2. In the shortcut menu click Open. What do you observe?
- My computer window is displayed
- Drive C: is opened 
2. In My computer window, double click drive C: 
How many files and folders are displayed?
4.Click the file menu then point to New, then click folder. A folder with a name “New folder” is created. Note that the folder name is highlighted
5.Type the word Registers to replace the temporary folder name.
6. Press the enter key. 
The folder Registers is created. Click on the start button 
2. Select programs, accessories then windows explorer. 
Note: You can also start windows explorer from the Start menu or by pressing the Windows logo key together with the letter E. 
Look at the folder listing in the left pane. Some folders are preceded by a positive sign.
Click the positive sign. What do you observe?
1. Subfolders within the selected folder are displayed
2. The selected folder is moved one place down
On clicking the plus sign in front of a folder expands the tree and the sign is replaced by a - (minus) sign. This is referred to as Expanding the tree.
Click the - (minus) sign of the expanded list. What do you observe?
1. Subfolders within are hidden
2. The selected folder are deleted
On clicking the - (minus) sign in front of a folder collapses the tree and the sign is replaced by a + (plus) sign. This is referred to as Collapsing the tree.
To view the content of a folder, click a folder on the left pane of the explorer window.
Note: If a subfolder contains subfolder (s) in it, it will be preceded by a + (plus) sign.
Copying files or folders to a different location
1. To copy a file or folder to e.g. secondary storage proceed as follows
2. Insert the secondary storage medium into the drive. 
3. Open the windows explorer. 
4. From the left window pane, click the folder or file you want to copy. 
5. From the Edit menu, click the Copy command. 
6. Select the location; a folder on the secondary storge medium where you want to place the copy.
7. Click Edit menu once again then click Paste. A duplicate copy is placed in the new location
Moving files or folders to a different location
To move a file or folder to e.g. to a different location, proceed as follows:
1. Select the destination e.g. the floppy drive. 
2. Select the file or folder you want to move. 
3. From the Edit menu, click the Cut option. 
4. Select the destination the file or folder is to be moved to.
5. Click Edit menu once more then click Paste. The target file or folder is moved to the new location
Renaming a file or folder
Renaming is the process of changing the name given to a particular file .
To rename a file:
1. Open the windows explorer 
2. Select the file or folder you want to rename
3. From the file menu, select the command rename. The old name is highlighted
4. Type in the new name then press the enter key. 
Look at the illustration that shows this procedure next. 

Sorting files
Windows automatically sorts items alphabetically in ascending order or descending order. However you can sort the items manually by categories such as by name, date size, type and date modified. To do this;
1. Open the drive or folder that contains the items you want to sort 
2. Click the view menu, point to Arrange Icons by, and then click the appropriate sort command. 
Deleting files and folders
Delete refers to erasing or doing away with an item. This is a sensitive command that needs to be exercised with extra caution otherwise you may loose important data. Before we carry out this task, let us first explain what happens when you delete an item from removable device such as the floppy or from the hard disk.
Deleting items from the hard disk
When you delete any of these items from your hard disk, Windows places it in the Recycle Bin. 
Items remain in the Recycle Bin until you decide to empty the recyle bin or restore back to their original location . Therefore the Recycle Bin is a safety measure in windows that helps in holding files that may have been deleted from a hard drive by mistake. 
Deleting items from a removable drive
Items deleted from a removable drive such as a floppy disk are not sent to the Recycle Bin.
To delete a file or folder; 
1. Open Windows explorer and select the drive that contains the item to be deleted
2. Click the file or folder you wish to delete
3. From the explorer menu, click the File menu and then Delete. The File is deleted.
Note: You can also delete an item by right-clicking it and then clicking Delete. 
Click Next to try and Delete using the shortcut menu.
Existing files can be deleted from their storage location and media.
To delete a file or folder from a computer;
1. Open the location where the file /folder is save
2. Click on the file to select
3. Go to file menu and select delete 
4. The following dialogue box opens and prompting you to confirm delete.
5. Point and select yes to delete and NO to retain the file
When a file or folder is deleted it is temporarily stored in the recycle bin. A recycle bin is a system folder that acts as a buffer location for deleted files and folders.
Note1. there are shortcuts for carrying out these activities.
To delete a a file or folder tap the delete key from the keyboard and confirm delete dialog box opens.
You could also delete by pointing at the file/folder to select, right clicking and from the shortcut menu, clicking on delete
Note 2. Deleted files can be restored from the recycle bin.
To view deleted files in the recycle bin:
1. From the desktop, point and double-click on the recycle bin icon on the desktop to open it.
2. Select a file/folder you want to restore.
3. From the file menu, select restore.
You could also restore a file using shortcut menu. To do this: 
Open the recycle bin, point to a file or folder you want to restore, right click and from the shortcut menu select restore. 
Note 3. Files can be permanently deleted from the recycle bin. Once this is done these files and folder cannot be restored.
To empty the recycle bin, open the recycle bin by double clicking.
From the edit menu click on select all to select all the files and folders in the recycle bib
From the file menu, select delete.
A dialogue box opens and prompts you to confirm delete.
By clicking yes the content of the recycle bin are permanently deleted.
Searching for files or folders
Often users forget where they might have saved their files and folders . An operating system provides a way for searching files and folders under its control. some of the criteria used to search include:
1. name 
2. date and time of modification
3. file type 
4. size of the file 
To search for a missing file or folder using a Windows operating system, the following procedure should be followed:
1. Click on the start button. 
2. Select search 
3. Click on files or folders.
The following are the search options for windows XP operating system:
The search options enables you to search for:
1. picture, music or video files
2. Specific application files such as word, excel, Access etc. 
3. All files and folders in the computer.
Under each of these options, more distinctive options are provided such as keywords and search location.
Definition: It is a software that controls the hardware and the software resources and the activities that take place in a computer. 
- Input/output devices eg Keyboard, mouse, printers 
Operating systems are classified according to three criteria:
A single user operating system allows only one program to run at a time. This means that if you are working in a spreadsheet and want to write a memo, you must shut down the spreadsheet application and open up a word processor. This is annoying, especially if you need to quote some data from the spreadsheet in your memo! So new operating systems were designed that allowed multiple programs to run at the same time. 
The simplest form is multi-tasking. What this really means is that the programs are taking turns with the processor. It allows a single user to have the spreadsheet and the word processor open at the same time, and even more. Now the user can see to copy data from one to the other. Much better!!
The computer must decide on how many time slices each program gets. The active program gets the most. Next is programs that are doing things but which aren't the foreground program. Last is programs that are open but aren't doing anything. They need a little bit of time every now and then to see if they are supposed to do something yet. 
The next step up in complexity is multiple users. On a network several users can be using the same computer or even the same program on that computer. This is called time-sharing.

If a computer has multiple CPUs, it can do multiprocessing. Rather than a single CPU giving out turns to various programs, the different CPUs can work simultaneously. Speed increases immensely. Of course cost does, too!
It is possible for a computer to use more than one operating system through the use of virtual machines." Virtual" means it's not really there. But programs written for different operating systems are fooled into thinking their required operating system is present. 

Originally the operating system was created by each company that manufactured a processor and motherboard. So each operating system was proprietary, that is, unique to each manufacturer. Problem: changing to a new computer meant your software had to be replaced! Not good marketing. So there was pressure early on to standardize things so that software could be transferred to the new (and of course better!) computer. This required more standardization in operating systems.
The winner in the PC market was MS-DOS, Microsoft's Disk Operating System, and its twin at IBM, PC-DOS, also written by Microsoft. Now it's hard to recall those days when each computer had its own unique operating system. 
Windows 95 and Windows 98 are actual operating systems on their own. The previous versions of Windows use DOS as the operating system and adding a graphical user interface which will do multitasking. But with Windows 95 Microsoft released an operating system that can take advantage of the 32-bit processors.
Windows Me (Windows Millennium Edition) is an upgrade of Windows 98, release date Sept. 14, 2000. The system resources required for this operating system are significantly higher than previous versions of Windows.

Windows NT (the NT apparently came from New Technology) is an operating system for client-server type networks. The last version of NT has a user interface that is practically identical to Windows 95. Since Windows NT was designed for the higher demands of networks, it had higher demands itself for disk space and memory.
Windows 2000 is an upgrade of Windows NT rather than of Windows 98.

Windows XP is an upgrade to Windows 2000. It comes in two versions - Home and Professional. The Professional version contains all the features of the Home version plus more business features, like networking and security features. 
Windows Vista was released in early 2007. It has higher requirements for memory and processor speed than previous versions of Windows. Vista comes in several different flavors for home and business purposes.

Windows CE is for small devices like palmtop and handheld computers. Lite versions of a number of major applications are available to run on these devices. You can link your small computer to a regular one to synchronize documents and data.
The Apple Macintosh is a multitasking operating system that was the first graphical interface to achieve commercial success. The Mac was an immediate success in the areas of graphics production, and still commands the lion's share of that market. Apple made a major marketing error when they decided to keep their hardware and software under tight control rather than licensing others to produce compatible devices and programs. While the Apple products were of high quality, they were always more expensive than comparable products that were compatible with Microsoft's DOS operating system. This is an example of how a near lock on a market can be lost in a twinkling. 
The current version is Mac OS X, which is version 10. Since January 2002, all new Mac computers use Mac OS X. Subversions are named Jaguar, Panther, Tiger, Leopard....

IBM's 32-bit operating system, OS/2, was a popular system for businesses with complex computer systems from IBM. It was powerful and had a nice graphical interface. Programs written for DOS and Windows could also run on this system. This system has never really caught on for PCs and is no longer marketed. 
UNIX is an operating system developed by Bell Labs to handle complex scientific applications. University networks are likely to use UNIX, as are Internet Service Providers. A lot of people have experience with UNIX from their college work. Many computer old-timers love UNIX and its command line interface. But all those commands are not easy to remember for newcomers. X-Windows is a graphical interface for UNIX that some think is even easier to work with than Windows 98.
Linux is an operating system similar to UNIX that is becoming more and more popular. It is a open-source program created by Linus Torvalds at the University of Finland, starting in 1991. Open source means that the underlying computer code is freely available to everyone. Programmers can work directly with the code and add features. They can sell their customized version of Linux, as long as the source code is still open to others. 

